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Foreword 
Having read through Part 1 (Setting up Gmax) and Part 6 (Gmax Basics) we are now 
ready to tackle our first loco. Remember, this is something anybody can do… 
 
Although I’ll be going into more detail in this part it’s probably going to be frequently 
updated as you tell me where more explanation and/or illustrations are needed – so 
check my web site for updates and make sure you have the latest one. 
 
This loco will not be a model of any particular prototype for because it will be easier. 
It will be in any case fairly easy to change it afterwards to resemble something else. 
I’ve also given it a snappy name in the style of ‘LBSC’ (the most successful 
locomotive designer of all time) whose biography I’ve been reading of late. ‘Primus’ 
as all fans of Stargate SG1 will know means ‘the first one’ in Latin. 
 
Creating freelance models was very popular in the 1940s and1950s, unfortunately 
the current obsession with exact scale has tended to make the art of freelancing a 
dying art. Even if a model is freelance it should be at least plausible in an engineering 
sense, so I’ll be mentioning a few things that should be avoided if you want to make 
the model believable. Also while ‘Primus’ will be British outline there is no reason why 
the basic design could not be altered to make it American outline or even narrow 
gauge. 

Wheels 
I usually start with the wheel sets, for the good reason that parts of the superstructure 
need to be built with reference to the wheel centres. I have a ‘wheel kit’ on my 
website here that allows the construction of wheels of any diameter so download this 
GMax file and open it.  

Pressing ‘H’ will open the ‘Select Objects’ dialog box so you can see what we have 
loaded. There’s a dummy (which to prove want a nice bloke I am is already animated 
as described in Part 5), and objects for the boss, rim and spoke. 

http://www.44090digitalmodels.co.uk/Trainz/BitsBox/Files/wheel+kit_05.gmax
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Before we go any further, make sure GMax is set up as described in Part 1, 
especially the bit about incremental saving and aut omatic backups! 
 
The first thing to do is to decide on the wheel diameter. A typical six coupled 
industrial tank like ‘Primus’ would have had wheels of around 3’9” diameter, so select 
the rim object by pressing ‘H’, choosing the rim and then ‘Select’. It’s good practice 
by the way always to select things using the ‘Selec t Objects’ dialog box rather 
than ‘Select and Move’ on the top toolbar – the rea son being it’s very easy to 
slightly move something away from it’s starting pos ition with ‘Select and 
Move’ . 

 
Here the rim object has been selected. Note that the X,Y,Z axis appears at the 0,0,0 
position in 3D space (see Part 6 if this is unclear). This is because I’ve moved the 
pivot point of the rim object to 0,0,0. The rim object itself is correctly positioned for a 
standard gauge wheel i.e. we don’t need to move it in 
X, and is simply a closed spline object which we 
looked at in Part 6. 
 
The first thing to do is to move the ‘rim’ object to the 
correct Y position. Having selected it choose ‘Select 
and Move’ on the top toolbar. Now type the radius of 
the wheel into the Y input field at the bottom of the 
GMax window. 
 
Another dying art these days is 
doing sums in your head so a few of 
you will probably need a calculator at 
this point.  Anyway, 3’9” is 45”, half 
of which is 22,5”. 
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Note that the value is negative as we want to move the rim towards the front of the 
loco. 
 
The rim has moved 22,5” (we always build things full size in GMax ) forwards. Note 
that the pivot point has also moved which we didn’t want so we’ll have to move it 
back to 0,0,0.  
 
So, go to the ‘Hierarchy’ tab and choose ‘Affect Pivot Only’ and in the coordinate 
boxes at the bottom of the GMax window set the Y value to 0 by right click on the 
spinner arrows or by typing ‘’ into the Y field. 
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The pivot point has been moved to 0,0,0. 
 
Now we can create the rim mesh by lathing the 
spline. The ‘Lathe’ modifier has already been 
applied to the rim but it was deactivated – activate it 
now by clicking on the light bulb. Doesn’t look quite 
right yet though. 
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We have to modify the centre point of the ‘Lathe’ modifier to get the expected result, 
so open the ‘Lathe’ modifier in the stack and click on ‘Axis’. Making sure that the 
‘Select and Move’ tool is still active set the coordinates of the centre point back 0,0,0 
(right clicking on the X,Y and Z spinners is quickest). 
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That’s more like it. Now, a 
warning about polys. The 
‘Lathe’ modifier has 
parameters for 
‘segments’ – setting this 
too high will drive the 
poly count up which we 
don’t want . Larger wheels 
will need more segments 
but for a wheel of this size 
20 is about right. 
 
Now to create the rest of 
the spokes – about 16 
would be ok, so select the 
spoke01 object and left 
click on the ‘Angle Snap 
Toggle icon to select it and 
then right click the same 
icon to open the settings 
dialog. The angle between 
the spokes will be 360/16 = 22,5 degrees.  
 
Now select the ‘Rotate’ tool in the top toolbar and 
holding down the SHIFT key drag on the X axis to 
create a copy of the ‘spoke01’ object. Just drag long 
enough so that the copy snaps to 22,5 degrees from 
the original spoke.  Let go of the left mouse button 
when the copy appears. Another dialog box opens 
now: 
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Change the value in ‘Number of Copies’ to 7 (we need 7 copies as each spoke is 
actually two spokes). For a 15 spoke wheel I’d have deleted the top half of the spoke 
of course and made 14 copies. A larger diameter would also mean making the 
spokes longer.  

 
Now to join everything together to make a single object, select the ‘Lathe’ object, right 
click over it in the modifier stack and choose ‘Collapse All’. In the ‘Modify’ tab choose 
‘Attach List’ and select everything, finally choosing ‘Attach’ in the ‘Attach List’ dialog 
box. Note: I’ve pressed ‘F3’ here to turn on the shading  in the viewport…  
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We now have just two objects in the model, the wheel and 
the dummy. The ‘rim’ object can be mirrored over now to 
create the right hand wheel. Select the ‘rim’ object and add 
a ‘Mirror’ modifier to the stack.  
 
Make sure that the ‘Copy’ box is ticked, and that the ‘Mirror 
Centre’ is at X=0 (click on it in the stack, choose ‘Select 
and Move’ on the top toolbar and check the coordinates at 
the bottom of the GMax window). 
 
As the pivot point of the ‘rim’ object was set to 0,0,0 there 
should be no need to change anything. 
 
Warning! There is also a ‘Mirror Selected Objects’ icon 
in the top toolbar – this should not be used, as it  tends 
to turn meshes inside out when exporting to Trainz. 
 
 
 
 
 
 
 
 
 

 
Collapse the stack of the rim object and rename it to ‘wheel01’. 
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This might have seemed a bit long winded to create a 
wheel set but we have covered quite a bit of ground so 
far. 
 
 
 
 
 
 
 
 
  
 
 
 
The wheel set is still at  0,0,0 so the next step is to move it (and the dummy 
‘b.r.wheel01’) up 22,5”, the radius of the wheel you’ll remember. Press ‘H’, select the 
wheel01 object and make the Select and Move’ tool active. In the Z coordinate field 
type 22,5” and hit ENTER to move the wheel. Do the same for ‘b.r.wheel01’. 
 

 
 
Now to create the other two wheel sets. First move ‘wheel01’ and ‘b.r.wheel01’ 
forward by 7’ (or wherever you what the front driver to be). This should be no problem 
if you’ve been following the steps so far! Don’t forget that ‘forward’ means in the –Y 
direction. 
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Now with the ‘Select and Move’ tool active and the SHIFT key held down drag on the 
Y axis to create a clone of ‘wheel01’. The clone will be named automatically 
‘wheel02’. 

Click on ‘OK’ to create the copy, and with ‘wheel02’ still selected change the Y 
coordinate back to 0 to put ‘wheel02’ at Y=0. 
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Create a third wheel set called ‘wheel03’ by copying ‘wheel02’ rearwards 7’. This can 
be done just by clicking on the Y axis when ‘wheel02’ is selected while holding down 
the SHIFT key with the ‘Select and Move’ tool active – don’t drag, just click. 
 
This will create a copy in the same position as the original. Now just enter 7’ in the Y 
coordinate box to move ‘wheel03’ rearwards. 
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Now we have all three wheels I’m beginning to think that 7’ + 
7’ wheelbase is a bit long, but no matter, we can easily 
change this later. Pity the poor guy building a physical model 
when he finds out that the wheelbase is wrong… 

Coupling Rods 
On to the coupling rods now,  first create a cylinder with the 
parameters as shown. Note that I’ve changed the standard 
parameters for ‘Height Segments’ and ‘Sides’ to something 
more reasonable – the defaults are much too high. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
I’m not worrying about 
the actual size of the 
cylinder, we’ll scale it 
down in a minute. 
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Select the ‘Select and Rotate’ tool in the top toolbar, and rotate the cylinder 90 
degrees around the Y axis.  

 
As we’ve still got the ‘Angle Snap Toggle’ icon selected the rotation will be in steps of 
22,5 degrees, but this is no problem. When this icon is not selected it allows much 
finer control, but we don’t need it in this case. 
 
Time to look at another very useful icon in the 
top toolbar, ‘Align’. With the cylinder selected 
choose ‘Align’ and then select ‘wheel01’.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Page 16 of 88 Version 9 

 
Check the Y and Z boxes of  ‘Align to World’, and select ‘Pivot Point’ for ‘Current 
Object’ and ‘Target Object’. Click on OK to align the cylinder. 

 
Now to align it to the face of the wheel boss. Select ‘Align’ again and select ‘wheel01’ 
again. This time check the X box of ‘Align to World’ and select ‘Pivot Point’ for the 
‘Current Object and ‘Maximum’ for the ‘Target Object’. 
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This simply aligns the pivot point with the maximum X coordinate of the ‘wheel01’ 
object. The cylinder now lies on the leftmost face of the 
wheel boss. 
 
Select the ‘Modify’ tab now and change the parameters 
of the cylinder. The height should be around 5”-6” for a 
standard gauge loco and the diameter about 3”. In the 
picture GMax has converted these values to metres 
automatically. 
 
 

 
 
Now move the cylinder down by the amount of the crank throw. For an outside 
cylinder loco this will always be half the piston stroke, but an inside cylinder loco 
could be different. A good figure would be 7” if you were not working from scale 
drawings. If you are then you will know what the crank throw should be. 
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Turn on the ‘Offset Mode 
Transform Type-in’ icon and enter 
7” in the Z coordinate box. This 
tells GMax to move the object 7” 
down from its current position.  
 

 
Copy the cylinder rearwards twice (same way as we copied the wheel sets), aligning 
the pivot points of the copies with the Y pivot points of ‘wheel02’ and ‘wheel03’. 

 



 Page 19 of 88 Version 9 

For the coupling rods we’ll create a box like so, again not worrying about the actual 
sizes: 
 

Centre the pivot point of ‘Box01’ to the object itself (Hierarchy tab, ‘Affect Pivot Only’ 
and ‘Centre to Object’) 
  
Using our newfound knowledge align the box to the centre coupling rod boss 
‘Cylinder02’. (Align X,Y and Z, current and target ‘Pivot point’). 
 

 
Convert  ‘Box01’ to editable mesh and add an ‘Edit Mesh’ modifier to the stack.  
Open the modifier and select ‘Polygon’. We can now select the outer face of ‘Box01’ 
to move it to the correct position. 
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If the polygon doesn’t turn red like this hit ‘F2’ to turn it on – it’s easier to see 
what is selected. 
 
Switch to top view (press ‘T) and choose the ‘Select and Move’ tool. 

 
Move the face until it is just inside the outer face of Cylnder02’. Switch back to 
perspective view (press ‘P’) and repeat for the inside face of the coupling rod (it might 
be easier to turn off shading with ‘F3’ while doing this). 
 
Collapse the stack when you are finished. 
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Switch to side view now (press ‘R’). With ‘Box01’ 
selected open the object in the stack and choose 
‘Vertex’.  
 
Make sure that ‘Ignore Backfacing’ is not selected 
as otherwise you won’t select the vertexes on the 
rear face of the rod! 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
With ‘Select and Move’ selected drag select the vertexes at the front end of the rod 
until they line up with the centre of the front wheel (no need to be dead accurate). 
 
Repeat for the rear end of the rod. 
 
 
 
 
 



 Page 22 of 88 Version 9 

 
 
Select ‘Cylinder01’, convert it to editable mesh and attach ‘Box01’, ‘Cylinder02’ and 
‘Cylinder03’ to it. Rename ‘Cylinder01’ to ‘rod_left’. 
 
Before we mirror the rod over to the right side we should delete a few extra polys – 
no point in deleting them twice… With ‘rod_left’ selected hit the right mouse button 
somewhere in the main GMax window and choose ‘Hide Unselected’. Now only the 
left rod is visible. 
 
Rotate the view so that you can see the rear side of the rod and select the rear faces 
of the rod and the bosses (ALT-middle mouse button). 

 
This time it might be useful to have ‘Ignore Backfacing’ on to avoid picking the front 
faces accidentally. Hit DEL to delete these faces. 
 
Now we can create the right rod by mirroring as we did for the first wheel set. 
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This time you’ll have to move the mirror centre to X=0, and to 
select Z as the mirror axis. 
 
 
 
 
 
 
 
 
 
Collapse the stack and choose ‘Element’. The right rod will 
turn red to denote it is selected. With the right button menu 
choose ‘Detach’ and name the new object ‘rod_right’. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right button menu again, choose ‘Unhide All’. Nearly there, we just need to ‘quarter’ 
the rods now. On a steam loco (or a diesel loco with coupling rods) the rods are 
never, ever positioned as they are in or model at the moment (are you listening 
Auran?). If they were the loco could get the rods in a position that would mean they 
could jam. Generally the right hand rods would be 90 degrees ahead of the left hand 
ones (bearing in mind that left and right are from the driver’s point of view looking 
forward). 
   
To achieve this we need to move the right hand rod forward and up 7” (our crank 
throw). 
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That’s about it for now, it’s taken a while to get this far, but using the techniques you 
have learned so far the rest of it won’t take as long. 
 
It’s certainly harder writing about it than doing it, to get this far shouldn’t take more 
than a couple of hours if that. Now you can get hold of Part 5 of this opus and 
animate it…. 
 
For the impatient or the bone-idle the model so far is downloadable here. I’d 
recommend that you make your own version though, it’s the best way to learn. 
  
I’ll assume that you’ve now animated the bogey using the instructions in Part 5 to 
save going through it all again – with practice this should take about five minutes. 
The animated bogey is available here if you want to have a look at it to compare it 
with yours. 

Footplate 
Now we’ll make a start on the superstructure, beginning with the footplate. As this is 
a freelance loco I can make things nice and easy for myself by making the footplate 
straight. 
 
Building on the information in Part 6, we’ll just sketch a footplate in the top view using 
two rectangles, joining these together as one editable spline object named ‘footplate’. 
Don’t worry about getting the dimensions right, we’ll correct these as we go. 

http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/Primus_009.gmax
http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/Primus_010.gmax
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The footplate is the two blue rectangles which we 
well now modify so that has the correct size and 
position. 
 
The rectangle in the centre represents the opening 
between the frames that was always present for 
access to the inside valve gear and other 
components. Frames were usually 4’1” apart on 
standard gauge locos, so select the footplate 
object and choose ‘Segment’ in the stack window. 
 
Pick one edge of the opening as shown and select 
the ‘Select and Move’ tool - the edge will turn red. 
In the X coordinate box enter 24,5” (half of 4’1”). 
 
 
 
 
 
 
 
 
 

 
 
The line segment will jump to the correct position. Repeat for the right hand side of 
the opening remembering that the X coordinate will be negative.  
 
Do the same to set the width of the outer rectangle to 8’6” (the usual width of a British 
loco) and recentre the pivot point of ‘footplate’ back to 0,0,0. Extrude the ‘footplate’ 
object 10mm to create a solid body. 
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In side view (press ‘R’) move the footplate up so that it is above the wheels (don’t 
want to have to make splashers do we?) 
 

 
We’ll adjust the final height and length once we’ve got the buffer beams, buffers and 
valances on. 

Buffer Beams 
For the buffer beams it’s easiest to use a box as this can be directly built on the 
underside of the footplate. Turn the model round so you can see the underside of the 
footplate and create a box. Make sure that ‘Auto Grid’ is turned on, this enables you 
to use and existing face to create the new object on. 
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I’ve turned off the grid with the ‘G’ key as it was getting in 
the way when looking from underneath. 
 
 
 
 
 
 
 
 
 
 

 
  
Go to the ‘Modify’ tab now and adjust the thickness of the 
beam – in this case the ‘Length’ parameter. Actually I got 
it about right for a steel beam, these would normally be 
made out of the same material as the mainframes at 
about 1 ¼” thick (around 32mm). Trainz models often 
seem to have buffer beams that are much too thick for 
some reason. 
 
We now have to adjust the width to be say 20mm less 
than the footplate each side. Convert the ‘Box01’ object 
to editable mesh and select the left hand face. 
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Using the ‘Align’ tool make the beam the same width as the footplate (Align to 
maximum X of the footplate). While the polygon is still selected turn on ‘Absolute 
Mode Transform Type-in’ and move the poly 20mm in the -X direction. Repeat for the 
right hand side. 
 
Now move the whole beam to the front edge of the footplate using ‘Align’ (Align min Y 
to min Y) and then rearwards 20mm. Make sure that ‘Editable Mesh’ is active in 
the stack this time and not ‘Polygon’ as we want to  move the whole object.  
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That’s the buffer beam positioned, now for the buffers. 

Buffers 
Create a box on the front face of the 
buffer beam using ‘Auto Grid’ (I 
don’t need to explain that again do 
I?). In the ‘Modify’ tab change the 
parameters for the length to 11”, 
width 11” and height 1”. These are 
fairly typical dimensions for British 
locos. 
 
The buffers are always positioned in 
the same place, on 5’8” centres and 
3’5¼” above the rail level (obvious 
really that the buffers have to have a 
standard position, although very 
early locos had the buffers an inch 
or two lower). 
 
Move the pivot point of the box back to the centre of the object. 5’8” is 68”, half of 
which is 34” and the height is 41,25”. Select the ‘Select and Move’ tool and move the 
box to this position. 
 
For the buffer housing and head 
I’ve hidden everything and have 
sketched (in the side view) the 
rough shape. The right hand end 
of the buffer is at 0,0. Sketching 
around the 0,0,0 point makes it 
easier to relocate the lathe axis 
later as we’ll see. 
 
 
 
 
 
 
Open the ‘Line01’ element in the modifier stack and select 
‘Vertex’. Now we have to correct the position of each of the vertex 
points. 
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The right hand point should be 
at X=0, and the other end point 
at the centre of the buffer head 
should be at Z=0, so position 
these two points first. 
 
 
 
 
 
 
The diameter of the housing will 
be 9,5”, to the two rightmost 
points should be at Z=4,25” 
(see what I mean about it being 
easier to build the buffer at the 
0,0,0 point?). 
 
Don’t forget that once you have 
the value you want in the 
coordinate boxes you can copy 
it with CTRL-C and paste it 
back in again for the second 
point with CTRL-V – saves 
typing. 
 
Carry on correcting the shape of the buffer until you are happy with it. The overall 
length from buffer beam to buffer head should be about 1’6”-1’8” although if you are 
planning to use BlueStar couplers (working ones) then the distance should be 1”6” to 
match the couplings. 
 
Also note that the buffer 
head has been sketched as 
three line segments rather 
than using a curve. This is 
more than accurate enough 
and keeps the poly count 
down. 
 
The buffer head diameter 
should be about 1’8”. 
 
 
 
Now we can lathe the line to create or buffer mesh. 
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Before we do though I’ve added a chamfer to two of the vertexes to round then off – 
again not a fillet to save polys. 

 
The ‘Lathe’ modifier has once again produced a strange result, the axis needs 
manipulating. 
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Open the ‘Lathe’ modifier and select ‘Axis’. Rotate the axis 
90 degrees about X. 
 
 
 
 
 
 
 
 
 
 
 

 
 
Now move the axis to Z=0. That’s more like it. 



 Page 33 of 88 Version 9 

If you select ‘Line01’ in the modifier stack again you’ll be able to move the vertex 
points of the line around to correct the shape. Selecting ‘Lathe’ will display the edited 
mesh again. Here I’ve corrected the shape a little. 

 
Let’s have a look at the poly count for this object – the 
counter is found on the ‘Utility’ tab.  
 
352 is on the high 
side bearing in 
mind we’ll have 4 
of them… 
 
Especially with 
round objects 
you should keep 
the number of 
segments as low 
as possible. 
 
In the ‘Modify’ tab have a look at the parameters for the 
‘Lathe’ modifier. In fact just selecting ‘Weld Core’ 
reduces the poly count to 336. Reducing the number of 
segments to 14 as well brings us down to 294. If you 
are unsure of what you can get away with it’s a good 
idea to save the buffer object at this stage while you 
can still easily modify it. Once to has been converted to editable mesh it won’t be so 
easy.  
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Something else that can help with the poly count on round 
objects is the ‘Optimise’ modifier, a little playing around here can 
also save a few polys. 

 
Down to 272 now, a saving of 320 for the whole loco. There are other possibilities for 
reducing the count still further, we’ll look at these another time. 
 
Move the pivot point to the centre of the buffer and align it to the box we added to the 
buffer beam. Rename ‘Line01’ to ‘buffer’, attach the box to it and then mirror the 
completed buffer over to the right side.  

 
Hide everything but the ‘buffer’ object. 
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There are a couple of faces on the rear of the buffers that can’t be seen in the 
finished model, so select and delete them. 
 
Now unhide everything and hide everything but the buffers and the buffer beam. 
Attach the beam to the ‘buffer’ object and delete the face on the top edge of the 
beam. 
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The buffer beam complete with buffers can now be mirrored to the rear of the loco. 

 
Quite a few of the basic techniques have been covered now, it’s worth practicising 
as much as possible though to save time and effort later. Especially important 
are moving pivot points, aligning objects to each o ther and the use of the 
‘Mirror’ modifier. All of these should become secon d nature! 

Valances 
These are the reinforcing angles beneath the footplate between the buffer beams. If 
they have a complicated shape I’d sketch the shape as a spline in side view, but here 
we’re making life easy for ourselves so we’ll use a box. 
 
In the same way that we did the buffer beam, sketch a box on the underside of the 
footplate using ‘Auto Grid’. 
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Modify the width of the box to be 50mm or so less than the width of the footplate on 
both sides. Select and delete the faces at each end, as they won’t be visible later. 
You can use the CTRL key to select several faces at  once by the way . 
 

 
To lengthen the box so that it butts up against each buffer beam we could use ‘Align’, 
but as both buffer beams are one object this is not so easy. We could create two 
temporary boxes using ‘Auto Grid’ on the back faces of the buffer beams, but in this 
case we’ll just eyeball it in the side view. 
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I’ve turned off the shading with ‘F3’ and selected ‘Vertex’ in the modifier stack for the 
valance object. Select and drag the vertexes until they butt up against the buffer 
beams. 
 
Make sure that ‘Ignore Backfacing’ is turned off ot herwise you won’t select all 
of the vertexes! 

 
Now select and delete the top polygon of the valance object, it’s blocking the opening 
in the footplate. Select the footplate object, collapse the stack and attach the buffers 
and valances to it to make one object. 
 

A useful side effect of the fact that GMax normally produces single sided polygons 
can be seen when viewing the footplate from the top and from underneath. From the 
top the footplate is open because the bottom poly of the valance is facing 
downwards. Only when looking from underneath can this poly be seen which is 
exactly what we want. 
  
The model at this stage can be downloaded here. 

http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/Primus_017.gmax
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Boiler and Smokebox 
Now on to the parts that start really making it look like a steam loco. Create a cylinder 
making sure that ‘Height Segments’ is set to 1. 

 
Rotate the cylinder and position it at X=0, moving it up so that it sits above the 
footplate 
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A bit on the big side, we’ll change the cylinder’s parameters to reduce the diameter to 
about 5’. (It would be a lot easier with a drawing).  

Rename the cylinder to ‘boiler’, convert it to editable mesh 
and delete the two end polygons. 
 
In the modifier stack choose ‘Edge’ and drag select the 
edges at the front end of the boiler – they will turn red 
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In the rollout under the modifier stack find and choose 
‘Create Shape from Edges’.  
 
This will create a new spline from the selected edges 
called ‘Shape01’. Select ‘Linear’ before clicking ‘OK’. 
 
 
 
 
 
 
 
 
 
 
 
 
Hide everything but ‘Shape01’ and switch to the front view with the ‘F’ key. 

 
 
Move the pivot point of ‘Shape01’ to the centre of the object and rescale ‘Shape01’ to 

be slightly larger, the ‘Uniform Scale’ icon on the top toolbar looks like this:  
About 103% should do it, so that the smokebox is larger than the boiler. 
 
Now create a rectangle 4’1” wide (the smokebox almost always has to fit between the 
frames) and centre it at X=0. 
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Turn the view to look at the objects in 3D: 

 
 
They are lying on different planes, so align the rectangle to the circle in the Y 
direction. 
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Here the shapes have 
been attached together 
and trimmed as described 
in Part 6. 
 
I’ve also welded all the 
vertexes together ready 
for extruding. 
 
Important! If you forget 
the welding the filleting 
and extruding will not 
work!  
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Select the two vertexes at the joint between the circle and 
the rectangle and add a fillet. 
 
 
 
 
 
 
 
 
 
Change the ‘Steps’ in the 
Interpolation rollout to 2 
to reduce the poly count 
see part 6). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add an ‘Extrude’ modifier to 
the stack to create the 
smokebox. 
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Sit back and admire the chunky lines… 

Cab, Tanks and Bunker 
I’m going to do these parts as one line using holding down the SHIFT key to force 
horizontal/vertical segments. This has the advantage that you just need to ensure the 
end point of the line is welded to the start point  - otherwise the fillets won’t work and 
we won’t be able to make a mesh out of it. 

 
 
I’m not worrying too much about the dimensions yet, and the sketch is square 
cornered. Also note that the bunker rear is straight. An extended bunker (wider at the 
top) would probably look better but doing the animated coal load is then more 
complicated. The bunker is a bit low, but that is also easily changed. Next step is to 
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add some curved corners. If we select all four corners in the cab cutout together they 
can all be filleted at the same time with the same radius. 

I’ve increased the size of the coal bunker as well now. 

 
Don’t forget to reduce the number of steps in the i nterpolation rollout to reduce 
the number of segments in the curves. 
 
With steps=2 we have 31 polys, the default steps=6 would give us 51 (40 extra for 
the loco).
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We have to move the tank/cab/bunker to its final position of course. 
 

 
 
The proportions are still a bit of a disaster which is why it’s easier to work from 
drawings. The important thing at this stage though is to get the basic model done so 
that we can correct it later – if we were working from drawings we’d try and build it 
right in the first place of course. 
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Hide everything but the tank side and in the modifier stack 
select ‘Edge’. Choose the edges as shown in red. 

 
 
 

We are going to drag these edges to create new polygons. With ‘Select and Move’ 
active and the SHIFT key held down drag the edges in the –X direction. 
 
This is a very easy way 
of creating polygons 
based on existing 
geometry. 
 
Releasing the SHIFT key 
leaves the new edges 
selected so we can 
position them straight 
away. 
 
The tanks on steam 
locos do not usually go 
from one side to the 
other, they are two 
separate tanks that stop 
at the outboard face of 
the frames. 
 
These ones will end at 2’1” from the loco centreline so we can just type this into the X 
coordinate box. 
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Oops, a few smoothing problems here, we need to apply a ‘Smooth’ modifier to sort 
this out. 
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I’d carry on in this manner, extruding 
edges to create new polygons as 
needed, bearing in mind that we only 
need to create one tank side which 
can be mirrored over when it is 
finished. 
 
This is the rear corner of the bunker, 
the edge has been extruded in the –
X direction 10mm to create the 
thickness and then the rear vertex 
point moved 10mm in the Y 
direction. 
 
Zooming in a bit closer I‘ll create the top rear edge of the bunker by extruding the 
edge of the last poly I created. 

 
Remember to select the edge with the ‘Select’ tool and not ‘Select and Move’. With 
‘Select and Move’ it’s very easy to move the edge in a direction that you didn’t want.. 
 
The new angled edge can easily be placed on the loco centreline by going the vertex 
mode and setting the X coordinate of both points to 0. 
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Sometimes this technique will create more edges than you really need as it creates 
four sided polys. If you want a three sided one you’ll have to weld points together like 
this: 

  



 Page 52 of 88 Version 9 

Select the vertex you want to weld and then with the ‘Select and Move’ tool active 
choose ‘Weld Target’ on the right button menu. Drag the extra point over so that it is 
on top on the one you want to weld it to. 
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Now for the curve of the cab roof and the front cab windows. There are several 
possibilities here but I prefer one that doesn’t involve a Boolean operation to cut the 
window out. Start by detaching cab front and then create the edge curves. 
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Choose ‘Select Open Edges’ and then ‘Create Shape from Edges’ to create the 
shape. Delete the cab front polygons. 
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Switch to the front view with ‘F’ and 
add the curve of the cab roof and 
the opening for the window using 
circles. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Move the two new circles to the same Y coordinate as the cab front. 
 

. 
Delete the top segment of the rectangle (‘choose ‘segment ‘ in the modifier stack and 
select and delete the segment.) Join all the cab front elements together and trim 
them. 
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Set the interpolation for the spline to 3 in this case, and weld the vertexes. Check the 
vertexes really are welded together by selecting each segment of the shape and 
dragging it. If the shape remains connected together then it is OK. Hit CTRL-Z to 
undo the change. 
 
Copy the window opening and the curve of the cab roof as a new element, we’ll need 
this for the rear of the cab. Select the segments and SHIFT drag them rearwards to 
duplicate them. 
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Detach these new curves and 
convert the cab front to editable 
mesh. If this part doesn’t work 
it’s probably because the 
shape wasn’t welded together  
– check the welding again. A 
typical symptom is that the shape 
disappears when you try to create 
the mesh. 
 
It’s also possible that the mesh 
may be created inside out. To 
correct this try creating a line in 
the front view and attach the 
shape to it. This is because the 
shape needs to be reoriented to 
the front view. Delete the line 
segment and try creating the mesh again. This trick is also useful if an extrusion goes 
in an unexpected direction. 
 

 
Repeat for the rear cab panel. 
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To make the inside of the cab we’ll clone the front and rear panels (note ‘Clone to 
Object is selected). 
 

 
This will create a copy as a new object in the same position.  Move the copy 
rearwards 10mm and flip the faces. You have to be in polygon mode to see the ‘Flip’ 
icon in the rollout and you have to select the polygons you want to flip. 
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The outboard edge of this new object should be moved 10mm in the –X direction 
now to the thickness of the cab side sheets. 
 
The rest of the cab interior is built up the same way, by copying existing polys, 
moving and flipping them. 
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A handy option in vertex mode is ‘Collapse’ which welds the 
selected points together no matter how far apart they are. 
Naturally if you select the whole model it will collapse the 
whole thing down to one point… 
 
 
 
 
 
 

 

Correcting the Proportions 
Time I think to correct some of the major howlers in the proportions Obviously when 
working from a plan you won’t need to do this, but it demonstrates how easy it would 
be to edit the model to look completely different. 
 
We’ll check the height of the cab first as it looks too high. A British mainline loco 
would be about 13’ high, an industrial shunter like this around 12’. Create a box 12’ 
high to see where we are at the moment. 
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Actually not far out. 

 
 
Select the vertexes of the cab and move them down. I’ve attached the cab interior to 
the tank object so I can move the whole lot in one go. If we need to we can always 
select and detach it again. 
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Looking from the side now the wheelbase seems too long, and you’d be unlikely to 
see a steam loco with the front axle in this position as in real life the cylinders and 
steam chest would be between the frames under the smokebox. 
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Press ‘H’ to open the ‘Select 
Objects’ dialog box and ensure 
that ‘Display Subtree’ and 
‘Select Subtree’ are selected. 
Selecting b.r.main will 
automatically select all the 
linked objects as well. 
 
Hide everything that is not 
selected to leave just the bogey 
on screen. 
 
 
 
 
 
 
 
 
 
 
 
We don’t want to mess with the wheels directly as t hey are linked to animated 
dummies. Always move the dummies in this case! 
 
I’m going to select the ‘b.r.wheel01’ object and move it rearwards 1’6” for starters. 

 
Note that as the dummies for the left and right rods were also linked to ‘b.r.wheel01’ 
they have also moved rearwards and are now 1’6” too long for the new wheelbase.   
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Select the rods and in vertex mode move the bosses on each of them 1’6” forwards. 

 
I’ll move the rear wheels 1’ forwards in a similar manner. The rear wheelbase was 
often more than the front wheelbase to allow more space for the firebox. 
 
In the next picture I’ve scaled the boiler and smokebox down as they seemed too 
large: 

 
Maybe make the tank tops a little higher? 
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Here I’ve simply selected and dragged the polys at the top of the side tanks 
upwards.. Note that as they are now above the centreline of the boiler now you can 
see a gap between them and the boiler which will need filling with a couple of new 
polys created by SHIFT dragging the edges. 

  
The new polys only need to be long enough to cover the gaps.  
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Another couple of edges need SHIFT dragging to extend the cab front as otherwise 
we’ll have a gap here as well. 

I’ve scaled the boiler down a little more now, this means that it moves away from the 
rear of the smokebox. To get the front edge of the boiler back in line with the rear of 
the smokebox I’ve added a temporary box to the rear of the smokebox so that I can 
align the front edges of the boiler to the min Y coordinate of the box.  
 
In a similar manner I’ll align the rear of the boiler to the front of the cab. 
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The position of the cutout in the footplate has also been adjusted and the valances 
made a little less deep. 

 
That’s better – this freelancing lark is not as easy as it looks. Download the model 
here to take a look at it. 

http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/Primus_038.gmax
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Cab Roof 
Now for something easy, select the edges of half of the cab front (if that makes any 
sense) and choose ‘Create Shape from Edges’ to extract a shape. Switch to front 
view with the ‘F’ key and hide everything but the new shape. Create a line in the front 
view and attach the shape to it. This is because the shape needs to be reoriented to 
the front view. Delete the line segment. 

 
Add an ‘Edit Spline’ modifier to the stack and select 
‘Spline’ in the modifier. Choose ‘Outline’ and drag the 
shape to create a thickness. You wouldn’t believe how 
many models I made without knowing this trick  - it was 
hard work  (about the only useful thing I found in the GMax 
Bible actually). 
 
The ‘Edit Spline’ modifier is there so that you can  
delete it and get back to the original shape if you  get 
the thickness wrong . 
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Drag the vertexes to create a bit of overhang for the roof, this can just be eyeballed. 

 
Move the vertex at the roof centreline to X=0 to avoid having a gap. 
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Now extrude the shape to produce half of the cab roof. 

 
Delete the extra poly on the roof centreline and mirror the roof over.  
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Adjust the roof overhang front and back by dragging vertexes. 
 

Chimney and Dome  
In the side view sketch a line as shown.  

 
 
Add fillets and change the 
interpolation to 3 or so.  
 
 
 
 
 
 
 
 
 
 
 
 
Delete the horizontal line segment at the base of the dome. 
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Add a ‘Lathe’ modifier. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Align the lathe axis with the min Y coordinate of the dome by dragging. Just before 
the dome mesh turns inside out stop dragging. Choose ‘Weld Core’ in the rollout. 

 
 In side view move down the dome until it just touches the boiler. 
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Now tweak the other vertexes down until they just touch the boiler. 

 
Always select the vertexes in pairs, font and back. We’ve actually selected four 
vertexes as you can see here: 
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Carry on moving the vertexes until the skirt of the dome is sitting on the boiler. This 
tweaking is best done in a 3D view with contrasting colours for boiler and dome. 
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Now adjust the next lines of vertexes to smooth the skirt out: 
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The chimney is made the same way of course as would safety valve bases etc etc. 
Here is ‘Primus’ in all his glory – well there are still lots of things that could be added 
(like brakes!) but constructing such things would mean repeating a lot of what has 
gone before. I think he looks quite cute in a Thomas the Tank Engine kind of way… 
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Before we look at exporting the 
model into Trainz a quick word 
about structuring the model. In 
the same way we linked 
everything in the bogey to 
‘b.r.main’ I’ve linked all the body 
parts to ‘boiler’. This enables the 
selection of either the bogey or 
body components for the 
purposes of hiding and exporting 
them, as I build everything in the 
one model (easier to make sure 
everything fits together and to 
keep track of the poly count).     
 
The poly count by the way is 
4994 but handrails etc will drive 
that up quite a bit although less 
than 7000 should be easy to 
achieve. 
 
Note as well that the mainframes 
are being treated as part of the 
body, the reason being it will make using the bogey for something else easier. I also 
didn’t mention how the frames were built but you should be able to figure that out for 
yourself. 
 
The model in this condition can be downloaded here. 

Adding Attachment Points 
Before we can export the model into Trainz there is the matter 
of the attachment points to consider. These tell Trainz where 
the loco starts and ends, where smoke comes out of it and 
where the bogey is attached for example. 
 
Attachment points are found in the ‘Helpers’ tab (where the 
animation dummies are) and the settings I normally use are 
shown here. 
 
A point looks like an X,Y,Z axis and should usually be created 
in top view. 
 
They also need to have particular names that Trainz will 
be looking for, misspelled and/or misplaced attachm ent 
points will cause a lot of grief. You have been war ned.  

http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/Primus_046.gmax


 Page 78 of 88 Version 9 

Two of the most important points are called 
‘a.limfront’ and ‘a.limback’. These are the virtual 
coupling points that Trainz uses when coupling 
to other stock. These should be equidistant from 
the 0,0,0 point of the model and it’s vital that 
‘a.limfront’ is at the bottom when looking at 
the model in top view . 
 
If when you look in top view the front of the 
loco is at the top of the screen (or worse to 
the left or the right) you’ve built the model 
the wrong way round and you’ll need to 
correct it before continuing. 
 
Here we see ‘Primus’ and the first two points. 
The X coordinate of both should be 0 (i.e. on the 
loco centreline), the Z coordinate 0,89m . The Y 
coordinates should coincide with the buffer faces 
front and rear and should be equidistant from 
Y=0. 
 
Link these two points to the ‘boiler’ object, or 
the object you are using as the base object 
for the body. This is to ensure that the points 
get exported with the rest of the model – if 
they don’t you’ll have all sorts of problems .  
 
 
 
 
 
The next points are called ‘a.bog0’, ‘a.bog1’ and ‘a.bog2’. ‘a.bog’ and ‘a.bog1’ control 
how the loco sits on the track, ‘a.bog2’ just goes along for the ride and is where the 
bogey that you can see is attached. A built-in invisible bogey will be attached to the 
other two points. 
 
‘a.bog0’ should be at X=0, Z=0 and aligned to the Y coordinate of the frontmost 
driving wheel. ‘a.bog1’ is at X=0, Z=0  and aligned to the Y coordinate of the 
rearmost driving wheel. 
 
‘a.bog2’ should be at 0,0,0. Again, link these three points to ‘boiler’ .
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We’ll want to see some smoke come out of the chimney so we’ll need a point called 
‘a.smoke0’ just above the chimney. 
 
Unlike the other points this one needs to have a sp ecial orientation. The smoke 
goes in the +Y direction of the point . Again, link this to ‘boiler’. 

 
Finally a point called ‘a.cabfront’ will be needed to attach an interior. This should be 
created in top view and aligned to the centre of the cab interior. It’s easiest to detach 
the interior from the model, set the pivot point to the centre of the object and align the 
point ‘a.cabfront’ to the pivot point. The interior can then be reattached or left 
separate and linked to ‘boiler’. 
 
That’s it for the points, these are the bare minimum for a steam loco. 

Setting up the Working Directories 
I'd suggest creating working directories somewhere outside TRS, preferably not on 
the C: drive in case Windows goes belly up and it's necessary to reinstall it. Being 
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paranoid I also have an automatic backup program that copies anything that has 
changed during the day to another drive, but as this is German software I won't go 
into further detail. It shouldn't be hard to find a differential backup utility on the 
Internet somewhere. I'd avoid one that uses some weird format for the backups 
though - this means you'll always need the original backup program to recover the 
data.  
 
Creating the working directories outside 
TRS also has other benefits, especially if 
you are using TRS2006. CMP is relatively 
slow to work with when you are constantly 
opening and editing files and worse, if the 
asset is open for editing when CMP 
decides to rebuild the database (which it 
does fairly often) some of your files may go 
walkies. Hence it's good to have everything 
stored somewhere else which also makes 
backing up easier - just back up your 'work 
in progress' folder.  
 
A further benefit is that I create a folder 'working files' in each of the working 
directories. Here I have GMax models, reference pictures, PSP files etc so that 
everything I need for the model is in one place. CMP can import the whole working 
directory and will ignore any file types it doesn't understand so the GMax and PSP 
files get stripped out. Just delete the 'working files' directory in CMP by opening the 
asset for editing in explorer and everything is tidy.  
 
With TRS2004 I'd still work like this and copy the working directory to 'Custom/Trains 
etc. Much easier in TRS2006 though.  
 
I've created skeleton working directories for the body here and the bogey here. I like 
to give the working directories the kuid number and a description to make it easier to 
see which is which in the 'work in progress' folder. I also give the exported files 
standard names such as 'bogey.im' or 'asset_body.im' to reduce the amount of 
editing the config file needs if you copy it to use for another asset. Before you import 
into TRS2004 orTRS2006 it's important to change the kuid number in the configs 
though, don't use mine. Also the loco config will need changing to reflect the kuid of 
the bogey. We'll go into this in more detail later when we export the models.  
 
Download the skeleton working directories and put them somewhere logical so you 
can find them again. Creating a desktop shortcut to the 'work in progress' folder is 
also a good idea. Copy your GMax files of the loco into the 'working files' folder of the 
loco. 

Exporting the Body 
Before exporting we must apply a texture to the par ts . Open the Material Editor 
and create a new Standard material. 

http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/01050_Primus_loco_skeleton.zip
http://www.44090digitalmodels.co.uk/Files/CC_Tutorials/Examples/50066_Primus_bogey_skeleton.zip
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Click on the ‘Ambient’ colour patch and set the colour value to 255 (pure white). The 
diffuse colour will also change at the same time. 
 
In the same way change the Specular colour value to 80. Set the Specular level to 
about 20 and then open the ‘Maps’ rollout to choose the texture file to use. 
 
The forgoing presupposes that you are using the specular exporters set up as 
described in Part 1, if you are using the standard exporters you can skip this bit.
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Click on the icon ‘None’ next to ‘Diffuse Colour’ to select the texture file. In the 
skeleton directory in the asset_body folder is a 4x4 black *.tga file. Select this as the 
texture. 
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The window changes to show 
the selected texture wrapped 
around a sphere. 
 
Important! Click on the 
blue/white icon to activate 
the texture! If you don’t do 
this the texture will not be 
displayed in GMax. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select all the body parts one 
after the other and apply a 
UVW Mapping modifier and 
choose ‘Box’ from the list of 
possible types.  
 
Then using the Select 
Objects’ dialog box select all 
of the body parts. 
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Open the Material library and drag the material to 
the selection. Choose ‘Assign to Selection’. The 
body has now been textured (not very well, but it 
will do for the purposes of testing the loco in 
Trainz). 
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Make doubly sure that the 
structure of the GMax model 
is similar to that shown here 
- all of the body parts and 
attachment points linked to 
a particular mesh, in this 
case 'boiler'.  
 
Select the 'boiler' mesh 
ensuring that 'Display 
Subtree' and 'Select 
Subtree' in the 'Select 
Objects' dialog box are 
selected. This will select the 
'boiler' mesh and everything 
linked to it. Now go to 'File -
> Export Selected….'  in the 
top menu bar of GMax and 
navigate to the body folder 
of the loco in your 'work in 
progress' directory.  
 
 

 
 
Export the model as 'asset_body.im'. The name is important, if you change it 
you'll need to edit the config file to match. 
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The file ‘asset.gmw’ is created by GMax during the export process, as is 
‘black.texture.txt’. The *.gmw’ is not required and can be deleted although CMP will 
ignore it during importing anyway. The texture file ‘black.tga’ was already in the 
skeleton that you downloaded. 

Exporting the Bogey 
Texture the bogey in the same manner and with the same material. 
 
This is exactly the same as exporting the body, the only difference is that the 
animation needs to be exported separately. After exporting the mesh into the working 
directory of the bogey export again and save the file as 'anim.kin' (The name is 
important, don't change it! ) 

Config Files  
There are a couple of things that must be changed in the config files of both body 
and bogey. Firstly in the bogie you'll need to change the kuid from mine 
(kuid2:44090:50066:1) to yours. I'd suggest just changing the creator id part of the 
kuid, i.e. kuid2:xxxxx:50066:1) where xxxxxx is the id that Auran issued you when 
registering your copy of Trainz. This can be found in your Auran Profile or in every 
post you make on the Auran Forum. The 50066 part of the kuid is the asset id and 
while it is not enforced anymore the range 50000-59999 was originally reserved for 
bogies. It makes sense to follow this convention so it's easier to know what the asset 
is if you just see the kuid number (in the Dispatcher directory of TRS2004 for 
example). TrainzObjects also uses the ranges to tell you what kind missing assets 
are.  
 
In the bogey this number is only found once, so edit it now. If the wheels of your loco 
are not 3'9" diameter you'll also have to edit the 'animdist' value, which is the 
distance in metres, the bogey travels along the track with one revolution of the 
wheels. You'll have to calculate this from the formula animdist = 3.1416 * (diameter of 
the wheel in metres). Not essential but useful is to change the author, description and 
username entries as these will be displayed by CMP in the main window and in the 
‘Asset Details’ rollout.  
 
In the config for the body file the bogey kuid is in two places, once in the 'bogey-2' tag 
and once in the 'kuid-table'. Change these references to match your bogey kuid .  
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Note that the trainz-build in both config files is 2.4, this is deliberate so the assets will 
be useable in TRS2004 as well. There is no earthly reason for making simple models 
like this TRS2006 only. 

Importing the Assets into TRS2006  
Fire up CMP and make sure that the kuids you have given the body and the bogey 
are not already in use. If they are the old asset will be overwritten by th e new 
ones without warning . Using 'File -> Import Content' navigate to where you have 
the working directories and import the body and then the bogey. Select the 'Open for 
Edit' tab and select both assets and commit them with CTRL-M. With any luck the 
assets will not show any errors and you are ready to try 'Primus' out in TRS2006. 
Remember to look for it under the name you gave it in the 'username' tag.  
 
Do not edit the assets with CCP, this will break th em.  

Importing the Assets into TRS2004  
Copy the working directory for the body into <your trainz installation 
path>/World/Custom/Trains and the bogey into <your trainz installation 
path>/World/Custom/Bogeys. Better delete the 'working files' folder from both of 
these though, I don't know what TRS2004 will do if it sees them (probably fall over). It 
really is easier with TRS2006 honestly. 

 
 
Please mail me if anything is unclear at paul.hobbs@web.de.  
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